
Multicasting sends a single copy of the Advanced Streaming Format (ASF) stream to those network clients that choose to view it.
Multiple copies of data are not sent across the network, nor is data sent to clients that do not want it. Multicasting allows 
multimedia applications to be deployed on the network while minimizing their demand for bandwidth. In contrast, unicasting 
sends a separate stream to each client that requests it. Multicasting saves bandwidth because only one stream is sent across 
the network, and it is shared by only those clients that choose to view the stream.



Codecs are compression/decompression algorithms that are used to make audio and video files a more manageable size. 
Windows Media Encoder applies a codec to audio and video content to compress it. This makes the file easily transferable over 
a network. Microsoft Windows Media Player uses the codec to decompress the content, and present it to the user. Codecs are 
created by many different companies to meet a variety of customer needs. You also can add other codecs to Windows Media 
Encoder. 



I-frames are independent video frames that contain all of the content from the frame. In contrast, P-frames (delta frames) contain
only data about what has changed in the video frame since the previous frame was transmitted.



The base Uniform Resource Locator (URL) is the point or directory that all relative paths use as their starting point. To set the 
base URL, either set the BaseURL property in Microsoft Windows Media Player (for instructions on how to do this, see Microsoft
Windows Media Player Software Development Kit), or set BaseURL in the .asx file that launches the .asf file or Advanced 
Streaming Format (ASF)    stream. If you do not set this property in either location, and the Windows Media Player client does not
find this information there, then Windows Media Player uses the path from the current FileName property. It does this by 
truncating the final portion of the FileName property, which is either an .asf or .asx file name extension. 



Quarter Common Interface Format displays images at a resolution of 176 by 144 pixels, and often is used for low-bandwidth 
video applications.



Common Interface Format displays images at a resolution of 352 by 288 pixels; however, it requires higher bandwidth for 
transmission.



An I-frame is a single video frame that contains all the information necessary to display an image in that frame. 



Media Stream Broadcast Distribution (MSBD) is the Microsoft transport protocol for streaming media.



Hypertext Transfer Protocol is the set of rules for exchanging files (text, graphic images, audio, video, and other 
multimedia files) on the World Wide Web.



An .nsc file is a file that describes a Windows Media Services station to Windows Media Player. Windows Media 
Player accesses the station file indirectly by way of an .asx file that directs the client to a specific .nsc file. 



Advanced Streaming Format (ASF) is a data format for streaming audio and video content, images, and script 
commands in packets over a network. ASF content can be an .asf file or a live stream generated by Windows 
Media Encoder. ASF content that is in the process of being delivered over a network is called an ASF stream. 



ASF Stream Descriptor (.asd) files are configuration files created and read by Windows Media Encoder. The file 
contains Encoder settings that describe the characteristics of a multimedia stream. The file also is read by 
Windows Media Station service to define the stream format supported by a given station.



ASF Stream Redirector (.asx) files are metafiles in ASCII format that use Extensible Markup Language (XML) and 
that load quickly on a client. An .asx file contains information for purposes such as the following:
· Transferring control from the browser to the Windows Media Player control so that streams can be directed to 

Windows Media Player.
· Representing an announcement of information necessary to access a program on a station.
· Providing references to multiple pieces of content and rules for the protocol rollover that the client uses to 

process the content pieces.
· Providing a playlist that defines the order in which pieces of content are streamed to Windows Media Player.



Template stream formats (TSFs) are a predefined group of settings that match content type and bit rate with 
appropriate audio and video codecs. Windows Media Encoder uses this feature to assist the user in quickly 
configuring the encoder to create ASF content.



Multiple bit rate video
Multiple bit rate video creates multiple content streams within one encoded ASF stream or file. The streams are 
encoded at different target bandwidths to allow a player to render content when network bandwidth is reduced. 
Multiple bit rate video also encodes an additional band that is calculated at 20%-33% below the lowest band 
selected in your configuration. This provides scalability to users who connect at the lower network bandwidth.  
Note: Using multiple bit rate video when encoding content requires an encoding platform that has 
at least a Pentium II processor running at 266 megahertz (MHz).    Multiple bit rate video content 
can only be decoded accurately by Microsoft Windows Media Player and Windows Media Services.



ASF Statistics

This tab provides statistics about the content stream being encoded. An ASF content stream has the following 
components: audio stream, video stream, and script command stream. If multiple bit rate video is used, select 
the video stream for which you want to view statistics.



ASF Panel

This panel presents information about the ASF stream being encoded by Windows Media Encoder.



Data Sent (ASF)

This statistic shows how much ASF content Windows Media Encoder has sent out since it was started. Data Sent
is measured in kilobytes (KB) until Windows Media Encoder has sent out more than 1 megabyte (MB) of ASF 
information. After that, Data Sent is measured in MBs. The Data Sent number changes only when an additional
MB of information is sent; depending on the amount of bandwidth that the encoder is streaming, the Data Sent 
number can stay the same for a while (especially if you are delivering data using a bandwidth of 28.8 kilobytes 
per second [Kbps]). 



Padding

This statistic shows how much of the encoded data packet was padded. Padding is extra data added to packets 
to make each the same size. If you are using script commands, they take up a portion of the bandwidth. 
Padding is added when the Script Commands option is selected, but no script commands currently are being 
sent. Also, if the compressed video does not fill up the entire bandwidth, any remaining space in the network 
bandwidth is filled with padding. 



Bit Rate (ASF)

This statistic represents the actual amount of the network bandwidth that is being used to deliver the ASF 
stream.



Audio Panel

This panel contains statistics about the audio portion of the ASF stream.



Data Sent (Audio)

This statistic shows how much audio information has been sent out since the encoder was started. 



Bit Rate (Audio)

This statistic represents the actual amount of the network bandwidth that is being used to deliver the audio 
portion of the ASF stream.



Script Commands    Panel
This panel provides information about script commands included in the ASF stream.



Data Sent 
This statistic shows how much script command information has been sent as part of the ASF stream.



Commands

This number represents the number of script commands sent during the encoding session.



Video Panel

This panel provides statistics about the video content stream.



Video Stream setting
This drop-down box allows you to choose which video stream statistics you want to view. 



Data Sent (Video)

This statistic shows how much video information has been sent as part of the ASF stream. 



Data Loss

This statistic provides the number of video frames lost, the size of this information loss, and the total percentage
of data lost during transmission of the ASF stream. 



Frames Lost. 
This statistic shows how many video frames were lost during transmission of the ASF stream. 



Frames Statistics

This column shows the comparative frame rate of    the encoded video. Frame rate is one of the indicators of 
quality video content. If the current frame rate is considerably lower than expected, your video content appears 
choppy. If the current frame rate is below average, then the current encoded content sometimes is changing at 
too fast a rate for the encoder to capture. If all statistics are within a reasonable range of difference, the content 
is being encoded correctly.



Bitrate Statistics

This column shows the comparative bit rates of the encoded video. Comparing this information between 
encoding sessions can help you choose the best codecs for your content, and also can alert you to possible 
problems in your content stream. 



Current Value

The statistics in this row reflect the current output of the encoder.



Average Value

The statistics in this row reflect the output of the encoder averaged across the time since the encoding process 
was started.



Expected Value

The values in this row are the established benchmarks for the codec configuration you are using.



Max Value

This statistic shows the largest amount of video information included in the ASF stream.



Min Value

This statistic shows the smallest amount of video information included in the ASF stream.



Connections Tab

The Connections tab lists the IP addresses of the computers that are connected to Windows Media Encoder.



Current Connections

This panel shows the IP addresses and connection protocol of clients that are connected to Windows Media 
Encoder.



IP Address

This is the IP address of the client that is connected to Windows Media Encoder. Windows Media Encoder can 
support up to 15 concurrent connections.



Connection Protocol    

This is the protocol    the client used to connect with Windows Media Encoder.    Windows Media Encoder supports 
two protocols:
MSBD and HTTP.



To configure and start Windows Media Encoder using QuickStart

1. In the Welcome window, select QuickStart.

2. Select the template stream format for this session.

3. To begin encoding the ASF stream, on the Encode menu, click Start.

Windows Media Encoder takes a few seconds to begin encoding the source information. The Summary 
Statistics panel displays how long the encoder has been encoding information and the amount of data sent.



To configure and start Windows Media Encoder using a template

1. In the Welcome window, select Template with Input/Output Options, and click OK.

2. In the Compression and Formats screen choose a template stream format for this session.    

3. In the Input Settings, Input Source screen, select either Live Source or AVI/WAV/MP3 File.

If you select Live Source, the capture devices are determined automatically by your preferred devices. To use
different capture devices, click Custom. 
If you select AVI/WAV/MP3 File, you automatically indicate you are going to output an .asf file. To indicate 
you want to deliver the content to a Windows Media server for immediate streaming, select Audio only; video
content cannot be transcoded directly to a content stream. 

4. In the Output Settings, Output Options screen, select where the ASF stream is to be sent. The ASF stream 
can be delivered to a Windows Media server, can be written to disk as an .asf file, or both. If you select both, 
you must complete the next two steps. 

5. If you are sending the content to a Windows Media server, in the Output Settings, Transmission screen, 
select the method that Windows Media Encoder uses to transmit the ASF stream to the Windows Media server. 
Either use a fixed IP port, or initiate the connection to the Windows Media Station service through DCOM. If you
choose the fixed port method, you also can select an HTTP port. If you choose to initiate the connection to the 
Windows Media Station service, specify the name of the server you want to connect to in the Station 
Manager box, and name the ASF stream coming from the encoder in the Stream alias box. 

6. If you are sending the content to a local .asf file, enter a file name for the .asf file in the Output settings, 
Output File screen. You also can limit the .asf file by file size and encoding duration. By selecting the 
Automatic Indexing check box, you can index your ASF file so that users can fast-forward and rewind while 
viewing the file. 

7.  Click Finish. The Windows Media Encoder Start window appears. On the Encode menu, click Start. Windows 
Media Encoder starts encoding the ASF stream. 

8. On the File menu, click Save or Save as, and type in a file name to save the configuration to an .asd file.

Windows Media Encoder takes a few seconds to begin encoding the source information. The Summary 
Statistics panel displays how long the encoder has been encoding information and the amount of data sent.



To configure Windows Media Encoder using custom settings

1. In the Welcome window, select Custom. 

2. In the Input Settings, Input Source screen, select either Live Source or AVI/WAV/MP3 File.

If you select Live Source, the Input Settings, Capture Source & Media Types screen appears. The 
capture devices are determined automatically by your preferred devices. To use different capture devices, click
Custom, and click the device in the list. Select the Script Commands check box if you want to include script 
commands in your ASF stream. 
If you select AVI/WAV/MP3 File, the Input Settings, Source File screen appears. Under File name, type 
the name of your source file, or click Browse to locate it on your computer. Leave this box blank to create a 
generic configuration for use with many different input files. To transmit the .asf file directly to a Windows 
Media server for streaming, select Audio only; video content cannot be streamed real-time due to the 
transcoding that occurs when transforming the video from .avi to .asf format.

3. In the Configure Stream, Bandwidth Selection screen, select either Use multiple bit rate video or Use 
single bit rate video.

If you select Use multiple bit rate video you can choose several network bandwidths to be used with your 
ASF stream.
If you select Use single bit rate video you choose one network bandwidth to use with your ASF stream. 

4. In the Configure Stream, Compression & Formats screen, for each type of content, choose the 
compression algorithm (or codec) that you want to use from the list. Most audio codecs have multiple formats. 
Choose the audio format you want from the list.

5. Under Video, click Advanced to specify additional video settings. 

6. In the Output Settings, Output Options screen, specify the destination of    the ASF stream. Click either: 

To Windows Media server(s) over a network. To deliver the ASF stream to a Windows Media server for 
unicasting or multicasting. 
To a local ASF file.  To save the stream as an .asf file for on-demand unicasting.
-or-
To both. 

7. If you output to a Windows Media server, from the Output Settings, Transmission screen, select the 
method that Windows Media Encoder uses to transmit the ASF stream to the Windows Media server. Use either
a fixed IP port, or initiate the connection to the Windows Media server. If you choose the fixed port method, you
also can select an HTTP port. If you choose to initiate the connection to the Windows Media server, specify the 
name of the server to which you want to connect in the Station Manager box, and name the ASF stream 
coming from the encoder in the Stream alias box.

8. If you output to a local ASF file, in the Output Settings, Output File screen specify a file name for the output
file. You also can limit the ASF file by file size and encoding duration. By selecting the Automatic Indexing 
check box, you can index your ASF file so that users can fast-forward and rewind while viewing the file. 

9. On the File menu, click Save or Save as, and type in a file name to save the .asd file. If you are sending this 
stream to a Windows Media server, make sure to provide this .asd file to your Windows Media system 
administrator. 

10. Click Finish to move to the Start window. On the Encode menu, click Start. Windows Media Encoder begins 
encoding the ASF stream. 

Windows Media Encoder takes a few seconds to begin encoding the source information. The Time display under 
Summary Statistics begins first; this verifies that your content is encoding. After a three-second delay, the 
amount of data being sent begins to accrue. 





To check your video setting

1. On the File menu, click Open. Click the .asd file that contains the video setting you want to check.

2. On the Encode menu, click Video.

3. Review the settings, make changes if necessary. 

Note
· The video settings available are provided by your video capture card manufacturer. For more information on 

the settings, use the Help available in the Video Settings dialog box.



To change the capture devices during configuration

1. On the File menu, click New.

2. Choose either the Template with I/O Options or Custom configuration method in the Welcome window. The 
Windows Media Encoder configuration wizard starts.

3. Use the wizard to configure Windows Media Encoder, click Next until the Input Settings, Capture Source 
screen appears.

4. To change the audio capture device, under Audio Capture, click Custom.

5. In the list, click the device.

6. To change the video capture device, under Video Capture in the Input Settings, Capture Source screen, 
click Custom.

7. In the list, click the device. Then click Next, and finish configuring the encoder.



To change the capture devices from the property pages

1. On the Encode menu, select Properties.

2. Click the Input tab.

3. Under Audio Capture, click Custom.

4. In the list, click the device.

5. Under Video Capture, click Custom.

6. In the list, click the device.



To specify a permanent source file during configuration

1. Select either the Template with I/O Options or Custom configuration method in the Welcome window. The 
Windows Media Encoder configuration wizard starts.

2. Use the wizard to configure Windows Media Encoder, and click Next until the Input Settings, Source File 
screen appears.

3. In the Input Settings, Source File screen, in the File name box, enter the path to the .avi or .wav file that 
you want to use.
 - or - 
Click Browse to select the file. 

4. Click Next, and finish creating the configuration.

5. On the File menu, click Save or Save as, and type in a file name to save the .asd file.



To specify a permanent source file after configuration

1. On the Encode menu, click Properties.

2. Click the Input tab.

3. Under AVI/WAV/MP3 File, type the name of the source file in the File name box
 - or - 
Click Browse to select the source file.

4. Click OK to accept the changes.

5. On the File menu, click Save or Save as, and type a file name to save the .asd file.



To specify the source file at encoding time

1. Choose either the Template with I/O Options or Custom configuration method in the Welcome window. The 
Windows Media Encoder configuration wizard starts.

2. Use the wizard to configure Windows Media Encoder, and click Next until the Input Settings, Source File 
screen appears.

3. In the Input Settings, Source File screen, do not enter information in the File name box. 

4. Click Next, and finish creating the configuration.

5. Optionally, on the File menu, click Save or Save as, and type in a file name to save the .asd file.

6. Before you start the encoder, on the File menu, click Input File. 
The Open box appears.

7. Click an .avi, .wav, or .mp3 file, and then click Open.

8. On the Encode menu, click Start to begin encoding the ASF stream.

When you start Windows Media Encoder, it uses the selected file. If you save the .asd file after you have 
specified which stored file to use as input, that stored file is not associated with the .asd file. When you open 
the .asd file to encode an ASF stream, you must select an .avi, .wav, or .mp3 file, unless you edit the properties 
of the file.



To set the output properties of a configuration to send content to a Windows Media server

1. On the Encode menu, click Properties. The property pages appear.

2. Click the Output tab.

3. To enable the network options, click To Windows Media server(s) over a network, and then select the 
options for your network connections. There are two methods that can be used to connect with a Windows 
Media server.

Select Allow Remote server(s) to connect via a fixed port, and choose the protocol to be used for the 
connection.
A Windows Media server can connect with the encoder via the MSBD protocol. To do so, the encoder must be 
at an identifiable IP address and have a dedicated port out of which    the content can be streamed. MSBD is 
always available as a connection method. A Windows Media server also can connect with the encoder via 
HTTP. This is useful for streaming content over firewalls. If your encoder and server are separated by a firewall,
HTTP is a good option. However, streaming data via HTTP has inherent limitations that result in poorer 
performance. HTTP streaming is not available if the encoder initiates the connection to the Windows Media 
server.
To select an open port on your encoder, click Query.
-or-
Select Initiate connection to a Windows Media Station Manager, and set the alias and server 
information.
In the Station Manager box, type the name of the Windows Media server that broadcasts the encoded ASF 
stream.
In the Stream Alias box, type a unique name for the ASF stream. 

4. To apply the settings and exit the property pages, click OK. The Start window appears.

5. To save your changes to the .asd file, on the File menu, click Save. 



To set the output properties of a configuration to send content to a local ASF file

1. On the Encode menu, click Properties. The property pages appear.

2. Click the Output tab.

3. Click To a local ASF file.

4. Type the name of the .asf file in the box, or click Browse to select an existing .asf file. The .asf file name 
extension is added automatically.

5. Optionally, enter any combination of the following .asf file elements.

Maximum Size. Enter a number that limits the size of the .asf file (in kilobytes) being encoded. When that 
limit is reached, the encoder stops. This is useful if you have limited storage space available for the .asf file.
Maximum Duration. Enter a period of time (in minutes, hours, or days) that limits the encoding of the .asf 
file. When that limit is reached, the encoder stops. This is useful if a file must play for a specific amount of 
time. If you select both Maximum Size and Maximum Duration, the encoder stops when the first of these 
limits is reached.
Automatic Indexing. Select this check box to turn Automatic indexing on or off. Indexing is turned on by 
default. Indexing the .asf file allows Windows Media Player to fast-forward or rewind the file during playback.

6. To apply the settings and close the property pages, click OK. The Start window appears.

7. To save your changes to the .asd file, on the File menu, click Save.



To set the output properties of a configuration to send content to both a Windows Media server and 
a local .asf file

1. On the Encode menu, select Properties. The property pages appear.

2. Click the Output tab.

3. Select both To Windows Media server(s) over a network and To a local ASF file.

4. Complete each section as described in their related procedures.

To set the output properties of a configuration to send content to a Windows Media server
To set the output properties of a configuration to send content to a local ASF file

5. To apply the settings and close the property pages, click OK. The Start window appears.

6. To save your changes to the .asd file, on the File menu, click Save. 



To configure Windows Media Encoder to allow a Windows Media server to connect to the ASF stream
via a fixed IP port 

1. Choose either the Template with I/O Options or Custom configuration method in the Welcome window. The 
Windows Media Encoder configuration wizard starts.

2. Use the wizard to configure Windows Media Encoder; click Next until the Output Settings, Transmissions 
screen appears.

3. Click Allow Remote server(s) to connect via a fixed port. 

4. In the MSBD on port box, type a port number, or click Query to have the encoder choose an IP port. 

5. To enable an HTTP connection to Windows Media Encoder, select the HTTP on port check box, type a port 
number, or click Query to have the encoder choose an open port. 

6. Click Next, and finish creating the configuration.

7. Optionally, to save the .asd file, on the File menu, click Save or Save as and type in a file name.

You have specified the IP port that the encoder uses to send the ASF stream; it is also the port that you must 
specify when identifying the ASF stream to a Windows Media server. If the Windows Media server is separated 
from Windows Media Encoder by a firewall, you can connect via HTTP on a fixed port. If you choose to use a port 
other than port 80 for the HHTP connection, you must open that port in the firewall. HTTP streaming has inherent
limitations that    lower the quality of the content provided, and must be used with care. 



To configure Windows Media Encoder to connect to a Windows Media server using a stream alias

1. Choose either the Template with I/O Options or Custom configuration method in the Welcome window. The 
Windows Media Encoder configuration wizard starts.

2. Use the wizard to configure Windows Media Encoder; click Next until the Output Settings, Transmissions 
screen appears.

3. Select Initiate connection to a Windows Media Station Manager. 

4. In the Station Manager box, enter the name of the Windows Media server. 

5. In the Stream alias box, enter a name for the ASF stream. This alias can be used by a Windows Media server 
or a Windows Media Player client to identify the ASF stream. 

6. Click Next, and finish creating the configuration.

7. To save the .asd file, on the File menu, click Save or Save as, and type in a file name.

Note    
· If you are running Windows Media Encoder on a Microsoft Windows 95-based computer, portions of Windows 

Media Encoder require DCOM95 to communicate with Windows Media component services. The encoder still 
functions without DCOM installed, but in some instances you need DCOM95 to use Windows Media Encoder 
with the Windows Media component services. To install DCOM95, see the Microsoft Web site.



To verify that the video card is configured correctly

1. On the Encode menu, click Video Capture Settings. 
The Video Capture Settings dialog box appears.

2. Use the information displayed in the Video Capture Settings dialog box to make sure that the proper video 
card input has been selected. If you are unsure of the proper settings, see your video card documentation for 
instructions.

3. To verify that you are using the correct video card settings, start the encoder. On the View menu, click 
Preview Video. The video, as it will appear after encoding, appears.



To verify that the audio card is configured correctly

1. On the View menu, click Volume Control. 
The Volume Control dialog box appears.

2. In the Volume Control dialog box, on the Options menu, click Properties.

3. In the Properties dialog box, click the audio card you are using in the Mixer device list.

4. Under Adjust volume for, select Recording because Windows Media Encoder is using your audio card to 
receive the audio.

5. Under Show the following volume controls, make sure that you have selected the proper audio inputs. If 
you are not sure which to select, turn on all of them. The Wave Input mixer control dialog box appears.

6. Select the appropriate audio input. 

7. To verify that the correct input is selected, start your audio source. The signal indicator in the Wave Input 
dialog box under Wave Input must light up. Close the Wave Input dialog box. 



To start and stop encoding with Windows Media Encoder

1. On the Encode menu, click Start. 
Under Summary Statistics, the camera icon turns green, and its caption reads On Air. This signals that you 
are encoding an ASF stream.

2. To stop encoding the ASF stream, on the Encode menu, click Stop. The color of the camera icon changes to 
gray, and its caption reads Off Air.



To insert a script command into the ASF stream

1. In the Script Commands dialog box, type a command.
Typing in the Script Commands dialog box activates the Send button.

2. To send the command, click Send.

3. The commands are placed into the ASF stream.

Note    
· The Windows Media Encoder configuration must support script commands.    Several template stream formats 

support script commands as do custom configurations. If you want to use a configuration that does not 
support script commands, you can edit the properties of the configuration to enable them.



To edit a Windows Media Encoder configuration file

1. On the Encode menu, click Properties.

2. Click the tabs you want to edit. The tabs displayed differ depending on the configuration method used. 

· Template tab. Click this tab to select a different template stream format. (QuickStart or Template 
configurations only). 

· Input tab. Click this tab to change the audio and video content sources.
· Output tab. Click this tab to change the output options for the ASF stream.
· Bandwidth tab. Click this tab to change the target bandwidth(s) for the ASF stream. (Custom configurations 

only)
· Compression tab. Click this tab to change the audio and video codecs used to compress the ASF stream. 

(Custom configurations only)
Make the desired changes. You are returned to the Start window.

3. To save your changes to the configuration file, on the File menu, click Save. 



To view Windows Media Encoder Statistics

1. On the Encode menu, click Start.

2. Once Windows Media Encoder begins to encode an ASF stream, on the View menu, click Statistics. 

3. The Windows Media Encoder Statistics dialog box appears with the ASF Statistics tab selected.



To adjust the audio/video synchronization

Windows Media Encoder must be running and you must be able to view the ASF stream with a    Microsoft 
Windows Media Player client. 
· On a Windows Media Encoder computer, press the plus key (+) to temporarily increase the speed of the audio,

or press the minus key (-) to temporarily decrease the speed of the audio relative to the video. To adjust longer
delays between the audio and video content, press the plus or minus key repeatedly until the timing is 
corrected.

Each time you press the plus or minus key, you increase or decrease the speed by 25 milliseconds.



To test Windows Media Encoder

1. In the Start window, note the information under Connections. It must contain the reference for the stream. 
Record the Media Stream Broadcast Distribution (MSBD) reference. For example, MSBD://encoder_name:7007,
MSBD is the transport protocol, encoder_name is the name of the encoding computer, and 7007 is the IP port 
to which the data is being streamed. Having this information allows another computer to access the data 
stream for the encoder. If Connections is dimmed, you are encoding the stream only to a local file. Change 
your output properties to encode    a stream directly to a Windows Media server.

2. On the Encode menu, click Start.

3. On another computer on the same network, start Microsoft Windows Media Player.

4. On the File menu in Windows Media Player, click Open.

5. In the Open dialog box, type the stream reference from Windows Media Encoder. For example, type:

msbd://encoder_name
This opens a TCP link between the Windows Media Player client and Windows Media Encoder. Windows Media 
Player buffers some information, and then begins rendering the ASF stream. If you do not use the default port 
on the encoder (port 7007), the port must be specified in the location name (for example, 
msbd://encoder_name:7009).

6. If the stream can be viewed successfully from the encoder, then test the stream coming from the Windows 
Media server.

7. In the Open dialog box, type the stream reference of    the Windows Media server. For example, type:

mms://server_name/stream_alias
This opens a TCP link between the Windows Media Player client and the Windows Media server. Windows Media
Player buffers some information, and then begins rendering the ASF stream. If the stream cannot be viewed, 
verify that the stream reference is correct and then test the connectivity between the server and encoder.    

8. Provided all streams are tested successfully, the content is ready to be published to your users.

Note    
· Use the MSBD protocol only to test Windows Media Encoder. Windows Media Encoder supports a maximum of 

15 concurrent MSBD connections. 



To adjust the MaxBufferTime or DiscardPercentage values

1. On the Windows taskbar, click Start, and then click Run.

2. Type Regedit, and click OK. Registry Editor opens.

3. In Registry Editor, open \\HKeyLocalMachine\Software\Microsoft\NetShow\REX\Parameters.

4. In this directory key, add a DWORD value named MaxBufferTime, and set a value for this parameter.

5. In the same directory key, add another DWORD value named DiscardPercentage, and set a value for this 
parameter.

Note  
· Incorrectly editing the registry may severely damage your system. Before making changes to the registry, you 

should back up any valued data on the computer.



To specify target audiences for a multiple bit rate encoding configuration

1. Choose the Custom configuration method in the Welcome window. The Windows Media Encoder configuration 
wizard starts.

2. Use the wizard to configure Windows Media Encoder; click Next until the Configure Stream, Bandwidth 
Selection screen appears. Select Use multiple bit rate video then click Next.

3. From the drop-down box select either Low Bandwidth or High Bandwidth target audiences.

4. From the list, select a target audience. 

· Click Edit to change the selected target audience. The Edit Item window appears. From this window you can 
change the Target Audience description and the bit rate of the video stream. 

· Click Remove to remove the selected target audience. The target audience is removed from the list. The Add 
button is activated.

· Click Add to add a new target audience to the list. The Add Item window appears. From this window you can 
select the Target Audience description and the bit rate of the video stream. 

5. Click Next and finish configuring the encoder.



Windows Media Encoder Overview

Windows Media Encoder encodes audio and video content into an ASF stream that can be delivered to a 
Windows Media server or written to an .asf file. The content can be from a live source or an existing .avi, .wav, or
.mp3 file. The output from Windows Media Encoder is a stream of information that can be heard or viewed with 
Microsoft Windows Media Player, or sent to a Windows Media server for multicasting, unicasting, or storage. 
Because the process of encoding and compressing video and audio content requires a high percentage of the 
computer’s processing capability, it is advised that you run Windows Media Encoder on a separate computer 
from the one that is running the Windows Media server components. 
Along with encoding the ASF stream, Windows Media Encoder is used to create an .asd file. An .asd file contains 
information about the media types, codecs, and bandwidth setting used to create an ASF stream; this 
information is referred to as the stream format. If you are delivering the stream to a Windows Media server and 
do not use a template stream format (TSF) to create your content stream, then it is necessary to propagate 
the .asd file to the Windows Media server so that the Windows Media component services can recognize the 
stream format. Template stream formats are known to the Windows Media component services, so you do not 
have to supply the .asd file to the server for it to interpret a stream that was encoded using a template. For more
information about using Windows Media Services to stream content, see Windows Media Services Help. 

Note 
· Portions of Windows Media Encoder require DCOM95 to communicate with the Windows Media component 

services. The encoder still can function without DCOM95 installed. If you need to install DCOM95, see the 
Microsoft Web site.

Related Topics



Understanding hardware and installation requirements

When you open Windows Media Encoder, it checks whether there is an audio or video card installed on the 
computer. You must have at least an audio card to encode from a live source. If you have multiple audio and 
video cards installed, you can select which cards Windows Media Encoder uses as its input source. If you have 
neither an audio nor video card, you can only encode content that has been stored as an audio (.wav or .mp3) or
video (.avi) file.
The Windows Media Encoder QuickStart Wizard is designed to create encoder configurations that receive live 
input through an audio or video card. To take input from audio or video files stored on a computer, use the 
template with Input/Output (I/O) options, or design a custom configuration.
While Windows Media Encoder is streaming ASF information, if the demands of the encoding process exceed the 
ability of the central processing unit (CPU) or capture device, Windows Media Encoder stops encoding, and 
displays a message. If the output from Windows Media Encoder is being streamed over a network, the clients 
stop receiving information when the encoder stops.

Related Topics



Selecting Windows Media Encoder configuration methods

Before you can start encoding with Windows Media Encoder, you must configure it to stream live information to a
Windows Media server and/or create an .asf file. After you open the encoder, you then either open an existing 
configuration file (an .asd file), or create a new configuration. The first time you open Windows Media Encoder, 
the Welcome window appears. This window provides three configuration methods to choose from:
· QuickStart. Microsoft recommends that you use QuickStart for the easiest configuration possible. The 

QuickStart wizard utilizes a set of template stream formats (TSFs) based on the type of content you want to 
deliver. 

· Template with I/O (Input/Output) options. If you have existing content that you want to use, the 
customizable template is a good choice. It allows you to specify the input and output files instead of using your
default settings.

· Customized configuration. Advanced users can customize the encoding to the exact parameters they need.

Related Topics



Understanding Windows Media Encoder configuration

The Windows Media Encoder configuration determines all the settings Windows Media Encoder uses to create an 
ASF stream. After you specify the settings used to configure Windows Media Encoder, you can save those 
settings as an .asd file. The next time that you want to recreate that scenario, you can open the .asd file instead 
of creating a new configuration. 
To make the configuration process easier, Windows Media Encoder comes with several template stream formats 
(TSFs) that are modeled after possible network scenarios. Use the template stream formats to begin creating 
your own .asd files either through the QuickStart configuration wizard, or through Template with I/O Options 
wizard. Template stream formats are used throughout Windows Media Technologies to identify the specifics of a 
content stream to the Windows Media component services and Windows Media Player clients.
The Windows Media Encoder template stream formats are designed for:
· Audio-only content over the Internet.
· Video with audio content over the Internet. 
· Multiple bit rate video with audio content over the Internet. 
· Video with audio content over an intranet.

To create a configuration that is customized for your network and your content, use the Custom configuration 
option. When you choose the custom option, you control the bandwidth, codecs, audio and video settings for 
your content stream. This configuration produces a custom stream format. If you are going to multicast this 
content stream, you must identify this stream format to the Windows Media component services. To do this save 
the configuration to an .asd file and then provide that .asd file to the Windows Media component services. The 
Windows Media component services reads the stream format from the .asd file, and supplies it to the Windows 
Media Player clients so that the stream generated from the encoder can be interpreted. 
Note 
· If you create a custom encoder configuration and do not propagate the .asd file to the Windows Media server, 

the server displays the error message: "Stream format not recognized".

Related Topics



Understanding template stream formats

Template stream formats (TSFs) are preconfigured settings for Windows Media Encoder to help you achieve the 
best quality for your encoded content. The codecs and bandwidths have been tested to ensure that they can 
provide the highest-quality presentation of your audio and video content. Not all scenarios can be envisioned; 
sometimes you must customize the settings if you have special content or network requirements.
The TSFs identify the configuration of standard ASF streams to the Windows Media component services and the 
Windows Media Player clients. The TSFs contain information on the following parameters:

· Target network bandwidth. This value identifies the minimum bandwidth of the user’s network connection.
If the user’s network connection does not support the target bandwidth, the user cannot receive the stream. 
Windows Media TSFs range in bandwidth from 16 kilobits per second(Kbps) to 3 megabits per second (Mbps). 
If your users range over a variety of bandwidths, consider using a multiple bit rate video template to create a 
stream that supports multiple bandwidths. 

· Content type. The type of content you plan to stream has a great impact on the audio and video codecs 
used and the video settings that provide optimal performance. There are a variety Windows Media TSFs for 
audio only streams as well as multimedia streaming templates.

· Multiple bit rate video. Multiple bit rate video templates use multiple bit rate video to encode multiple 
video bands into a single ASF stream or file so that the content can stream over variable network bandwidths.
This provides for the best client experience at higher bandwidths while still supporting lower bandwidth 
network connections. It also is useful for times when available network bandwidth is constrained and the 
stream needs to adapt to different conditions. When encoding multiple bit rate video at Internet bandwidths 
the minimum processor required is a Pentium II 266 MHz. To encode multiple bit rate video for higher 
bandwidths a dual Pentium II 400 MHz is required. 

· Web server video. Web server video templates are designed for ASF content that is destined to be 
streamed from a Web server without using Windows Media Services. These templates provide a simple audio 
and video stream suitable for HTTP streaming. 

Note
· Windows Media Services can also be used for HTTP streaming and provides a more reliable HTTP transport for 

streaming media than the streaming methods used by a Web server. If you use Windows Media Services for 
HTTP streaming, you can use any of the encoding templates. For more information on enabling and using 
Windows Media services for HTTP streaming, see Using HTTP streaming in Windows Media Services Help.

Related Topics



Specifying the input source

Select Live Source or AVI/WAV/MP3 file to include that medium in the ASF stream. Windows Media Encoder 
can use a live source or a file stored on a disk. The live source can be any audio or video content that the 
encoder can receive via the sound or video input jacks. The stored source can be any accessible .avi, .wav 
or .mp3 file. 
· Select Live source to encode from a live source. 
· Select AVI/WAV/MP3 File to encode from a stored source. 

Related Topics



Choosing video capture devices

You can have several different video capture devices on your encoding platform. Windows Media Encoder selects
the preferred devices on your encoding platform by default. You can change your input devices from the Input 
Settings, Capture Source & Media Types window when you create your configuration, or from the Input tab 
of the Properties page of an existing configuration. In either case, to use a different device, under Video 
capture, click Custom, and then select the device in the list. After you change your video device, save your 
configuration file, and check your video setting.
Note
· If you are going to save this configuration file for use on another encoder, choosing the default input devices 

allows the encoder to use whatever device is preferred on the system on which it is running, without 
reconfiguring the .asd file. 

Related Topics



Choosing audio capture devices

When your system was set up, a preferred audio recording device was specified. This device is chosen by 
Windows Media Encoder as the default audio recording device. Often, this device is the main sound device on 
your system. However, you can have several different audio recording devices in your system to provide 
different types of content. A custom audio recording device can be selected from the Input Settings, Capture 
Source & Media Types screen of the configuration wizard, or from the Input tab of an existing configuration’s 
property pages. 
In either case, to use these devices with Windows Media Encoder, under Audio Capture, select Custom, and 
then choose the device from the list. You can run many encoding sessions concurrently on your system, provided
each session has its own input device. If you are going to save this configuration file for use on another encoder, 
choosing the default input devices allows the encoder to use whatever device is preferred on the system on 
which it is running, without reconfiguring the .asd file. 

Related Topics



Specifying capture devices

If you have multiple input devices on your encoding platform, you can select which devices originate the live 
content for each configuration file. The preferred audio and video capture devices on the encoder are selected 
by default, but you can choose other available devices t by clicking custom on the capture device configuration 
page.
You can specify live capture devices during the configuration process, or from the property pages. If you use 
QuickStart to configure your encoder, you can change the capture devices through the property pages only.

Related Topics



Specifying a stored source file

If you use the Template with I/O Options or Custom configuration method, you can create a configuration 
for Windows Media Encoder with or without an associated source file. To specify a permanent source file for the 
configuration, save the configuration file with the source file selected. To specify the source file at encoding 
time, save the configuration file without an identified source; each time you encode content with the 
configuration, you must specify a source file.

Related Topics



Choosing a network bandwidth

Select a target bit rate for the output ASF stream. The first four choices are based on common network 
capabilities. The fifth choice allows you to customize the bandwidth if required by your application. The 
difference in the values shown between the capacity of the network connection and the actual bandwidth used 
allows for other network traffic.
· Internet 28.8 (22 kilobits per second [Kbps] actual). This bandwidth selection supports streaming of both 

audio and video content to clients using a network connection that operates at a minimum of 28.8 Kbps. 
· Internet 56 Modem (37 Kbps actual). This bandwidth selection supports streaming of both audio and video 

content to clients using a modem network connection that operates at 56 Kbps.
· Single Channel ISDN (50 Kbps actual). This bandwidth selection supports network connections at Integrated 

Services Digital Network (ISDN) rates. 
· Intranet (100 Kbps actual). This bandwidth selection supports clients on an intranet or local area network 

(LAN).
· Custom (bits per second [bps]). This bandwidth selection is for users whose system requires a customized 

bandwidth setting, such as those using a dedicated network that does not use one of the preceding 
bandwidths. When specifying the bit rate, consider other traffic that must pass over the network. Unlike the 
preconfigured bandwidth settings, Windows Media Encoder uses the entire bandwidth you specify for 
streaming ASF information. Note that this value is entered in bits per second, rather than kilobits per second.

Related Topics



Compressing the audio and video content

Use this screen to select which compression algorithms (codecs) to apply to your audio and video content. This 
screen has two panels, Audio and Video.
· Audio panel

Because some of the audio codecs have multiple formats, the Audio panel has options for both the codec and 
the format. Use the Codec list to select the audio codec. If the codec has multiple formats, use the Format 
list to select the amount or type of compression. The format of a codec is the sampling rate (in kilohertz [KHz] 
or hertz [Hz]) and sample depth (in bits). The larger the sampling rate and sample depth, the more information
is recorded. When more information is recorded, the audio content usually sounds better; however, the audio 
portion of the total bandwidth allocated also is larger. Remember that the audio stream must share the 
available network bandwidth with any video or script command streams. 
By default, the Windows Media Audio codec is selected because it usually produces the best sound quality in a 
media file with mixed media types. However, if you are creating a low bandwidth stream (below 20 Kbps) that 
has voice-only audio content, better results may be obtained by using the Sipro Labs ACELP.net codec.

· Video panel
Choose a video codec from the list next to Codec. Be sure to select a codec that can share the bandwidth with
the audio codec you have chosen. 
To adjust some advanced video settings, such as the size of the window displayed for the Windows Media 
Player client, the number of frames per second, and the number of I-frames, click Advanced.

Related Topics



Using the Windows Media Audio codec

Windows Media Audio is a new audio codec created by Microsoft. Windows Media Encoder    contains the latest 
version of this codec, Windows Media Audio codec version 2.The codec is designed to handle all types of audio 
content, from low-bandwidth 8-kilohertz (kHz) speech to 48-kHz stereo music. This codec is very resistant to 
degradation due to packet loss because it does not use interframe memory. This loss tolerance makes it 
excellent for use with streaming content. In addition, by using an improved encoding algorithm, this codec 
encodes and decodes much faster. The improved compression algorithm creates audio files that need much less 
disk space for storage than the same content created with other codecs. Content created using the Windows 
Media Audio codec is easily distributed over the Internet because the files can be downloaded more quickly. 
Therefore, if you are creating audio files for download, the Windows Media Audio codec is a great choice because
it provides near-CD-quality sound at half of the bandwidth required by most codecs.
During tests against comparable codecs, the Windows Media Audio codec provided much clearer sound with 
greater tonal distinction than the others. The combination of superb clarity and tonal depth produces better 
sounding music content across all supported bandwidths. The Windows Media Audio codec is a highly scalable 
codec that provides high-quality mono and stereo audio content over a wide range of bandwidths. This allows 
you to choose the best combination of bandwidth and sampling rates for your content. Thus, Microsoft has 
chosen to make it the default audio codec for most of the Windows Media Encoder configuration templates.



Adjusting input properties

This property page controls the type of media that can be included in the ASF stream. Windows Media Encoder 
can use a live source or a file stored on a disk. The live source can be any audio or video content that the 
encoder can receive via the sound or video capture cards. The stored source can be any accessible .avi, .wav, 
or .mp3 file. 
Encoding from a live source
· Select Live source. 
Use the Audio Capture and Video Capture check boxes to select the audio or video cards that receive the 
live input. For more information on verifying that the audio and video cards are configured correctly, see 
Verifying the Audio and Video Card Configuration. To change the capture source for audio or video content, 
under the capture type, click Custom, and select the desired capture device. 
The ability to select the Audio Capture and Video Capture check boxes varies depending on the configuration 
method used. If you use a template stream format to configure the encoder, the template defines the input 
options. For example, a video template has both audio and video capture devices, whereas an audio template is 
restricted to solely an audio device. However, if a custom configuration is used, you can turn Video Capture on 
and off. Audio Capture is the minimum required for live content encoding, and cannot be turned off in any 
configuration.
To include script commands in your ASF stream, select Script Commands. The Script Commands box is not 
accessible if your configuration is created with a template stream format. If you want to use script commands, 
you must create a custom configuration..
Encoding from a stored source
· Select AVI/WAV/MP3 File. 
This option allows you to specify an .avi, .wav, or .mp3 file for Windows Media Encoder to use as its input. You 
can specify this file now, or you can wait until you are ready to start the encoder. 
Note 
· If you are transmitting this content to a Windows Media server, rather than saving it to an .asf file, you must 

select Audio only. This setting applies only to custom encoder configurations.

Related Topics



Adjusting output properties

Use the Output properties tab to control how the encoded ASF content is distributed. You can encode content 
directly to a Windows Media server, save it to a local .asf file, or do both. 

Related Topics



Specifying the output

Select how you want Windows Media Encoder to output the ASF stream. The encoder can output the ASF stream 
to a Windows Media server or to a file. For streaming live events, the encoder sends the ASF stream to the 
Windows Media component services where it can be provided as a broadcast unicast or a multicast station. For 
on-demand unicasts, the encoder sends an ASF stream to be saved to disk as an .asf file so that the content can 
be played back later. You also can set the encoder to do both.

Related Topics 



Sending the ASF stream to a Windows Media server

You can select the method used to transmit the ASF stream to the Windows Media server during Windows Media 
Encoder configuration if you use the Template with I/O Options or Custom configuration wizard. You also can 
change the method from the property page after configuration is complete. 
Windows Media component services can identify the ASF stream using any of the following methods: 
· IP port. The IP port is a direct connection between the encoder and the server.    This method requires that the

encoder remain on a static location on the network. IP port connections are normally used for stream testing.
· HTTP port. Using the HTTP port enables your to stream across a network firewall. You can stream over both 

the IP port and the HTTP port simultaneously.
· Stream Alias. The encoder creates an alias on the Windows Media server that references its current address 

and port on the network. This alias is updated each time the configuration is started. Windows Media services 
can reference this alias in broadcast configurations and always have the correct stream reference. Thus, it is 
recommended that you use the stream alias method when delivering the ASF stream to Windows Media 
component services for broadcasting. 

Related Topics 



Sending the ASF stream to a local file

Saving the ASF content to a local .asf file allows you to provide the content via on-demand unicast later. The 
following control elements are available for the .asf file: 
· Name. Type a file name in the text box, or click Browse to select an existing .asf file. 
· Maximum Size. Limit the size of the .asf file to a specific number of kilobytes. This parameter is optional, but 

can be useful if you have limited storage space for your .asf file.
· Maximum Duration. Limit the encoding time of your .asf file by minutes, hours or days. This parameter is 

optional, but can be useful if your .asf file must conform to a specific time requirement.
· Automatic Indexing. Provide indexes within the .asf file to allow the user to fast-forward and rewind while 

viewing the content. This option is enabled by default. Indexing an .asf file can be a lengthy process. If you 
need to free your encoder to encode more content and your content does not include script commands, turn 
off indexing and use ASFChop or Windows Media ASF Indexer to index the file later. 

Related Topics 



Verifying the audio and video card configuration

If you think that Windows Media Encoder is configured correctly, but your audio or video content is not encoding 
properly, check the card configuration.

Related Topics 



Using advanced video settings

Change specific aspects of the video output in the ASF stream by manipulating advanced video settings. 
Changes made here have a great impact on the quality of content that users see and hear. Increasing the image 
size and number of frames per second, and decreasing the number of seconds per I-frames, places greater 
demands on your central processing unit (CPU) by Windows Media Encoder. The faster your CPU, the more 
frames per second and I-frames you can include in the ASF stream. If you make changes to these settings, test 
the content before delivering it to users. The Advanced Video Setting dialog box has two tabs, General and 
Clipping. For more information about a setting on the tab, click an area in the picture.

Related Topics 



General Tab
Use the General tab in the Advanced Video Setting dialog box to adjust settings that impact overall video 
quality.



Image Size Panel
To determine the height and width of the ASF content when it is viewed, use the Image Size panel. Quarter 
Common Interface Format (QCIF)and Common Interface Format (CIF) are predefined image standards; notice 
that CIF height and width are exactly double those of QCIF. These standards are provided because their image 
size (both height and width) is a standard that is supported by many codecs and video editing tools. The 
160x130 and 320x240 options provide video windows that are slightly smaller than QCIF and CIF, respectively. 
The slight decrease in image size allows for more bandwidth to be used for video frames, and can improve 
content quality in some scenarios. Use these options if video sharpness is more important than video size for 
your content.
Use Custom to define your own image size. When resizing an ASF stream with the Custom setting, be aware 
that many codecs require image size settings in multiples of 16. 



Frames/Second
To set the number of frames per second for the ASF stream, use the Frames/Second dialog box. The 
Frames/Second value can be set from 1 through 30. How much you adjust this value depends on the speed of 
the computer’s processor and whether the computer is encoding high-motion or low-motion video. If more 
frames per second are used, there are smaller changes between frames, and the video looks smoother. If fewer 
frames per second are used, the video has a slower motion transition rate, and thus video with a lot of motion 
can appear disjointed. However, the more frames per second your computer is required to encode, the harder 
the processor must work. It is possible to overwork your processor by requesting it to encode more action than 
its capability allows. If this happens, Windows Media Encoder stops encoding, and displays a message. 



Second/IFrame
The Second/IFrame dialog box displays the number of seconds that separate I-frames. All frames in between I-
frames are called delta frames. Delta frames contain only the information used to display change, and are 
considerably smaller than I-frames; however, the visual quality of delta frames is poor. As I-frames get farther 
apart, the size of the video (in bytes) gets smaller. As I-frames get closer together, the size of the video (in 
bytes) gets larger, and the computer’s processor must work harder. 



Pixel Format
The Pixel Format dialog box displays the color depth standard that has been selected. The video card that the 
computer is using to receive the video source has certain color standards that it can display best, for example, 
RGBH = 64k thousand colors and RGBT = 16 million colors. For information about which pixel format your card 
works best with, see the video card’s documentation. The pixel format is set automatically for the video card 
when you select one of the template stream formats. 



Delay Buffer
The Delay Buffer dialog box is the amount of video coming in from the video card (measured in seconds) that 
Windows Media Encoder stores before it starts transmitting ASF information. Five seconds is the default; it allows
enough information to build up so that the client does not have to wait (that is, buffer information) and the 
memory of the computer on which Windows Media Encoder is installed is not overloaded with delayed ASF 
information. Increasing the Delay Buffer can overload the computer’s memory, and affect the computer’s 
ability to encode information. Decreasing the Delay Buffer, in some circumstances, can cause clients to wait on 
Windows Media Encoder. 



Image Quality
The Image Quality slider lets you fine-tune the image quality. You can emphasize either video smoothness or 
image crispness. Video content is smooth when objects easily move from one position to another on the screen 
and the edges of objects are not jagged. Video content is crisp when images and motion are well defined and 
clearly delineated. As you increase the image crispness, the video becomes less smooth. In some cases, 
decreasing the image crispness makes the video look better. 



About the clipping tab
Clipping is used to determine what part of the video image is shown to the user. Clipping can be used to show 
specific portions of a video, increase image resolution, and increase perceptive quality. For more information 
about a setting on the tab, click the area in the picture.
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Clipping
Use the Clipping tab to change how much of the image is shown to the user.



Left
Defines the left edge of the viewing area. The default value is zero (0). Increasing this number crops the number 
of pixels you specify from the left edge of the client window. The following screen shot shows a representation of 
the window. The line along the left edge moves as the Left value is changed.



Top
Defines the upper edge of the viewing area. The default value is zero (0). Increasing this number crops the 
number of pixels you specify from the top edge of the client window. A representation of the window is shown 
below. The line along the upper edge moves as the Top value is changed.



Width
Defines the width of the viewing area. The default value is determined by the image size specified. For example, 
if you specify 160 x 120 pixels as the image size, the default width is 160 pixels. This is also the maximum width 
of the image. Decrease this number to crop pixels from the right edge of the image. The width is always relative 
to the left-edge setting. A representation of the window is shown below. The line along the right edge moves as 
the Width value is changed.



Height
Defines the height of the viewing area. The default value is determined by the image size specified. For example,
if you specified 160 x 120 pixels as the image size, the default height is 120 pixels. This is also the maximum 
height of the image. Decrease this number to crop pixels from the lower edge of the image. The height is always 
relative to the upper-edge setting. A representation of the window is shown below. The line along the lower edge 
moves as the Height value is changed.



Viewing Area
This area represents the amount of the captured video content that is shown to the user. The image is captured 
at the image size specified (that is, 160 x 120 pixels), but it is presented to the user at the size depicted here. 
Therefore, if you clip to a height and width of 50 pixels, the user views a content window of 50 x 50 pixels.



Troubleshooting buffer problems

Periods in which there are high volumes of network traffic can cause buffer problems. Most of the time, clients 
connect to Windows Media Encoder using TCP. When using TCP, clients are not likely to lose packets. However, 
during periods of high network traffic, Windows Media Encoder sometimes cannot send data as fast as it should. 
When this happens, it buffers the data instead. 
Windows Media Encoder can buffer for up to a maximum period of time set in MaxBufferTime in the registry. 
The default is 20 seconds. When the buffer is full and Windows Media Encoder still cannot send any data, the 
encoder attempts to create room in the buffer by discarding the oldest data. The amount of data that is 
discarded is determined by the DiscardPercentage setting in the registry. The default setting is 50 percent. 
When information is discarded from the buffer, Microsoft Windows Media Player indicates that packets have been
lost. 
MaxBufferTime and DiscardPercentage have default values, but do not appear in the registry. 
MaxBufferTime is the number of seconds of data that Windows Media Encoder can buffer. DiscardPercentage
is the amount of data in the buffer that is deleted when the buffer fills up. 
For example, using the default values--MaxBufferTime equals 20 seconds, and DiscardPercentage equals 50 
seconds--each time 20 seconds of data is buffered, the oldest 50 percent (that is, 10 seconds worth) is deleted to
make room for more incoming data.
To adjust the MaxBufferTime or DiscardPercentage values, you must add and then modify the values in the 
registry editor. 

Related Topics 



Viewing Windows Media statistics

The Windows Media Encoder Statistics dialog box provides information about the ASF stream that Windows 
Media Encoder is sending, Windows Media Encoder settings used to send the stream, and the IP addresses of the
computers that are receiving the stream. 

Related Topics 



Understanding the ASF statistics tab

While Windows Media Encoder is running, the ASF Statistics tab is being updated constantly with current 
information about the ASF stream and the audio and video files, and script commands used in the ASF stream. 
The ASF Statistics tab consists of four panels that show specific information about the encoding of the ASF 
stream. Click an area in the picture to find out more information about that item.

Related Topics 



Understanding the connections tab

The Connections tab lists the IP addresses of the computers that are connected to Windows Media Encoder. For 
more information about an area of the tab, click the following picture:

Related Topics 



Stopping Windows Media Encoder

Stopping Windows Media Encoder causes the content stream to stop encoding. Any computer that is receiving 
the content stream stops receiving content. After stopping the encoder, it can take a few seconds for the capture
cards to be reset. If you try to restart the encoder before they have been reset, a message appears telling you 
that the video device could not be started. Wait a few seconds, and then try to start the encoder again.
Windows Media Encoder can be stopped by clicking the Stop button, or by placing limits on the encoding 
session, such as limiting the file size or file duration.

Related Topics 



Starting Windows Media Encoder

After Windows Media Encoder is configured, it is ready to start encoding the ASF content. From the Encode 
menu, select Start or press the start button.
You are presented with the start window after a configuration is completed and any time you open Windows 
Media Encoder after saving a configuration file. The start window is composed of a toolbar and three information 
panels. The toolbar contains shortcuts to common menu commands, such as starting and stopping the encoder, 
preview video, and help. The panels contain the following information:
· The Summary Statistics panel provides information about the encoding session: how long it has been 

encoding, how much data has been encoded in the session, the current bit rate of the content currently being 
encoded, and the number of frames per second that are being encoded. This gives you a quick way to see 
whether or not the encoding session is providing good quality content.

· The Summary Settings panel provides information about the configuration you are using. It shows which 
codecs are being used, which input sources are being used, the output file (if any), and the name of the 
template stream format (TSF), if used.

· The Connection Information panel provides the stream reference for the encoder. This is the information 
that is used for connecting a Windows Media server or a Microsoft Windows Media Player client to the Windows
Media Encoder content stream.

If you have enabled script commands, the script command box is at the bottom of the start window. To send a 
script command, type the script command in the box, for example:
URL HTTP://www.example.microsoft.com
and then click the Send icon at the point in the content stream that you want the specified action to occur. Once 
sent, the script command is embedded into the ASF stream and is carried out by the Windows Media Player 
client during viewing. 
Once you start the encoder, statistics will start to accrue in the Summary Statistics panel, and the camera icon
will change from Off Air to On Air.
Before you start the encoder, check the following:
· Do you need to save your configuration?

If you just created a custom    Windows Media Encoder configuration, or you made changes to an existing 
configuration, you may want to save the configuration. To save a configuration, on the File menu, click Save 
As, and then name your configuration.

· Is the video card configured to use the proper input?
If you did not configure Windows Media Encoder to stream video content, or you do not have a video capture 
device installed, ignore this question. When you configure Windows Media Encoder, you establish the video 
capture card that the encoder uses as its input source. However, many video capture cards have multiple 
inputs. Use the Video Source Settings dialog box to make sure that the correct input is selected. On the 
Edit menu, click Video. In the Video Source Settings dialog box, verify that the correct video input is 
selected. For information about using the Video Source Settings dialog box, see your video card 
documentation.

If everything is correct, start Windows Media Encoder by pressing the start button.
Once started, the Source time begins to accrue almost immediately. After a few seconds, the Data Sent, 
Current Bit Rate, and Current Frames per second settings are displayed. 

Related Topics 



Understanding script commands

Script commands are commands that can be embedded in an .asf file or ASF stream. There are two types of 
script commands: URLs and Filenames. A URL is the path to a Web page; a Filename can be the path to 
another .asf or .asx file. When a command is embedded, it can be streamed over the network. When Microsoft 
Windows Media Player receives a script command, it transmits that command to an application that can run the 
command. For example, URLs are transmitted to the default browser, and paths to other .asf files are 
transmitted to the Windows Media Player client. If an .asf file is 2 minutes long and a Filename script command 
that references another .asf file is embedded 30 seconds into the file, the .asf file plays up to where the script 
command is embedded. Then the Windows Media Player client locates and begins streaming the .asf file 
referenced in the script command. The final 1.5 minutes of the original .asf file is not streamed. Script 
commands allow you to extend the capabilities of an .asf file or ASF stream. Use script commands to access 
other areas of the Internet or your local network, or to start other .asf files or streams. Script commands can be 
written using regular or relative paths.

Related Topics 



Understanding relative paths

A relative path is a shortened version of the complete path to a file. Relative paths are useful for two reasons: 
they make it easy to transport related content from one location to another without altering the content, and 
they are shorter than full paths. The length of a path is important when it must be sent across a network 
connection repeatedly (as in the case of Windows Media script commands). Shorter names mean less bandwidth 
is consumed in transporting these strings, possibly resulting in video content that looks better and audio content
that sounds better, yet use the same overall bandwidth. The path can be shortened because everything is 
related to a base URL. When creating script commands, you can use relative paths to identify the script 
commands.
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Dropping script commands

If you enable script commands as part of the configuration, you can insert script commands into the ASF stream 
while Windows Media Encoder is running. The Script Commands dialog box is activated when the encoder is 
started. 
When a script command is dropped, the command is placed in the ASF stream, and is executed when it is 
received by the Windows Media Player client. The results are not immediately visible. For example, if you send a 
URL as a script command, the URL is received immediately, but the time it takes the client computer to open a 
browser and for the browser to find the URL varies. The format of the command is the same as the script 
command format for Windows Media Author and conversion tools. First, state the type of command—either URL 
or Filename—and then give the command. For example,
URL http://example.Microsoft.com/
sends a URL-type command to the client, which invokes the URL once it is received. For more information about 
script commands and programming Microsoft Windows Media Player, see Microsoft Windows Media Player 
Software Development Kit.
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Adjusting properties in an existing configuration

Once you have created a configuration (.asd) file for Windows Media Encoder , you can make changes to that 
configuration by editing its property pages. The property pages available differ depending on whether you use a 
template stream format or a custom configuration.
The properties available when using template stream formats are:
· Template. Controls which template stream format is used by the .asd file.
· Input. Controls the source of the content; either Live or an AVI/WAV/MP3 file.
· Output. Controls where the .asf file or ASF stream is sent, either to a Windows Media server, a local .asf file, 

or both.

The properties available when using a custom configuration are:
· Input. Controls the source of the content; either Live or an AVI/WAV/MP3 file.
· Bandwidth. Controls the bandwidth at which the content streams. 
· Compression. Controls the audio and video codecs used to compress the content. Also provides access to 

advanced settings for image size, number of frames per second, number of seconds per I-frame, pixel format, 
delay buffer, and image quality. 

· Output. Controls where the .asf file or ASF stream is sent, either to a Windows Media server, a local .asf file, 
or both.
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Testing Windows Media Encoder

After configuring and starting Windows Media Encoder, it is a good idea to test it before providing content to 
users.
To test the encoder, use Microsoft Windows Media Player to receive the ASF stream from both Windows Media 
Encoder and the Windows Media server.
The stream originating from Windows Media Encoder is not a multicast stream, so do not use more than fifteen 
clients to test the encoder.
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Troubleshooting problems with audio/video synchronization

While testing a live ASF stream, if you notice that the audio and video content are not synchronized (that is, the 
audio is heard a little before or after the video is seen), use the plus or minus keys to adjust the timing. This 
problem is caused by a minor delay in the commands sent to the audio and video drivers, and is most noticeable
while watching, for example, video of a person speaking at a podium. 
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Understanding ISDN

Integrated Services Digital Network (ISDN) is an international communications standard for sending voice, video, 
and data over digital telephone lines. An ISDN implementation requires special metal wires, and supports data 
transfer rates of 64 kilobits per second (Kbps) on each channel. Most ISDN lines offered by telephone companies 
give you two channels at once, called B-channels. You can use one channel for voice and the other for data, or 
you can use both channels for data to give you data rates of 128 Kbps.
Basic Rate ISDN (BRI) service consists of two 64-Kbps B-channels and one 64-Kbps D-channel for transmitting 
control information. Primary Rate ISDN (PRI) service consists of 23 B-channels and one D-channel (in the United 
States) or 30 B-channels and 2 D-channels (in Europe). 
To use ISDN, you must have a terminal adapter to regulate the transfer of data between your computer and the 
network. Terminal adapters often are called ISDN modems, even though they do not perform the signal 
modulation and demodulation that is required to translate digital data into analog data.



Creating multiple bit rate video

When you custom configure Windows Media Encoder you can choose whether or not the configuration you are 
creating uses multiple bit rate video. Several template stream formats also use multiple bit rate video.
Multiple bit rate video can be used to provide users with better quality content during times of network 
congestion. When you use multiple bit rate video, your video content is recorded at multiple bandwidths that you
select. These bandwidths range between 18 Kbps and 10 Mbps. Multiple bit rate video also encodes an additional
band that is calculated at 20%-33% below the lowest band selected in your configuration. This provides 
scalability to users who connect at the lower network bandwidth. Using multiple bit rate video gives Windows 
Media Player the ability to switch to a lower bandwidth video stream when the reception quality of the higher 
bandwidth deteriorates, or the network connection does not support the higher bandwidth. When encoding 
multiple bit rate video at Internet bandwidths (28.8 Kbps and 56 Kbps), the minimum processor required is a 
Pentium II 266 MHz. To encode multiple bit rate video on higher bandwidths, a dual Pentium II 400 MHz is 
required. 
Encoding single stream video creates ASF content that supports only one target bandwidth. This content is best 
suited for network environments that have constant available bandwidth or for content that is hosted on an HTTP
server without Windows Media Services. ASF content created with a single video stream has lower processor 
requirements and requires less storage space.
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Selecting target audiences for multiple bit rate video configurations

Windows Media Encoder has two categories of target audiences, Low Bandwidth and High Bandwidth. When 
you select the target audience category, you are presented with a default grouping of five target audiences. You 
can edit and remove these target audiences from your configuration. Once you have less than five target 
audiences defined for your category you can add new target audiences to the category.
Each target audience has a default bandwidth that you can customize to meet your needs. The following table 
identifies the bandwidth ranges that can be used by each target audience:
Target Audience Bandwidth range 

28.8 Modem 18 - 27 Kbps
56 Dial-up Modem 28 - 37 Kbps
Single Channel ISDN 38 - 55 Kbps
Dual ISDN 56 - 120 Kbps
Intranet 121 - 250 Kbps
High Speed Internet 251 - 500 Kbps
LAN 501 - 700 Kbps
High Speed LAN 701 Kbps - 10 Mbps

 

A video stream is encoded into the ASF stream for each target audience you select. You can also modify these 
bandwidths after the configuration is complete from the properties page. 

Note 
· Multiple bit rate video also encodes an additional video band that is calculated at 20%-33% below the lowest 

band selected in your configuration. This provides scalability to users who connect at the lower network 
bandwidth. 

· When you customize the bandwidths supported by each video stream, be aware that you cannot combine low 
and high bandwidth streams. If you create a video stream for a target network bandwidth that is below 80 
Kbps, the maximum bandwidth for additional video streams is constrained to 300 Kbps. To encode multiple bit 
rate video that supports bandwidths greater than 300 Kbps, you must not specify any video streams that are 
lower than 80 Kbps. 
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Using HTTP streaming with Windows Media Encoder

If your Windows Media server is protected by a firewall, you still can receive source content from a Windows 
Media Encoder located outside of the firewall using a feature called HHTP streaming.
This option is designed to enable a Windows Media encoder located on the Internet to distribute an ASF stream 
to a Windows Media server located within a firewall. Standard firewall configurations do not allow distribution of 
a stream from Windows Media Encoder inside a firewall out to a Windows Media server installation on the 
Internet. 
HTTP streaming is enabled by default for QuickStart configurations. The port reference for HTTP connections is 
listed in the stream reference box of the encoder. To change the port or to disable HTTP streaming, clear the 
checkbox for HTTP streaming on the output properties page of your encoder configuration.
If you use the Template or Custom configuration methods you can select HTTP streaming from the Output 
Settings, Transmissions page of the configuration wizard.    
Note 
· Check with your network administrator to avoid HTTP port conflicts or to open the port in your firewall.
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